MLA FORMAT:______________________________________________________________
 Margins - All margins should be one inch. Go to the toolbar at the top of the screen.
Click the Layout tab. Click the Margins icon. Click Normal with top, bottom, left, and right
all saying 1”.
 Line Spacing - All text should be double-spaced. Do not put extra spaces below the title or
between paragraphs. Go to the toolbar at the top of the screen. Click the Home tab. In the
Paragraph section, click the icon with the Up and Down Arrows. A menu will drop down.
Click 2.0. Make sure to remove spacing before and after paragraph from this menu.
 Justification - Justification refers to the alignment of the text. All text should be aligned left,
except the title should be centered and the page number should be aligned right. The
alignment buttons are located in the Paragraph section of the Home tab.
 Font – Under the Home tab, set font theme to Times New Roman and the font size to 12.
 Pagination - Put your last name and the page number in the upper-right corner of every page.
At the top of the screen, click the Insert tab. Then, click the Page Number icon. Select Top
of Page, third option, Plain Number 3.
 The number 1 should be displayed in the header.
Type in your last name, making sure you capitalize the first letter, and press the spacebar
once. Format the font style and size to fit your paper. Click the Close Header and Footer
icon on the right side of the Design tab in the toolbar.
 Name and Title - Unless otherwise required, you do not need a cover page. On the first line
of the page, type your first and last name. Press enter and type your professor’s name; on
the third line, type the course name and number, and on the fourth line, list the date. Below
the date, type and center the title of your paper. Below the title, begin your paragraph.
Remember to indent the first line of every paragraph one-half inch by pressing the Tab
button (above the Caps Lock button) one time.
Reminders ____________________________________________________________
1) Make sure to save your work often on a portable hard drive/flash drive, or you can email
your document to yourself by attaching it to an email.
2) The Communications Lab computers support Office XP, Office Vista, Office 2010 and
up, and Open Office.
3) Spacing in the examples of this handout do not always follow MLA guideline for sake of
formatting and saving space.
4) Currently, the lab’s computers have Windows 7 as its operating system.

Any question regarding this guide can be answered by a friendly staff member.
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Tonja Nelson
Professor Webb
English 1113
23 May 2016
Heroes: An Analytical Approach
 1” 

Dominion, power, and the hope of nations remain steadfast in the hearts of all humanity.
Heroes, as a resolution to attain such things, are needed in former as well as present and future
times. As a result, these formidable giants have not had to succumb to the boundaries of time and
space; therefore, within each parallel realm reside the tales of their great deeds. Societies, in the

CREATING IN-TEXT CITATIONS

past, have always relied on strong powers to come save the day and so continue to reign supreme.
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CREATING IN-TEXT CITATIONS
Documentation is a method of giving credit to the creator of that source. To correspond with a
Works Cited page, you must also make shortened in-text citations (also called parenthetical
citations) within the body of your paper. This mark will directly refer the reader to the
documentation information on the Works Cited page. Every piece of information that is not
your own idea or is not considered common knowledge should be cited.
 Cite everything that is quoted or paraphrased. Paraphrasing is when you take ideas from
a source and put them into your own words.
 If you are summarizing, introduce the details of the source such as author, title of work,
and if necessary where the piece was published in the first sentence. Then, use
summarization tactics through the course of your paragraph.
 The first word of the in-text citation should match the first word of the works cited entry
to which it corresponds. For example, if the works cited entry begins with the author’s
last name, then use the author’s last name for your in-text citation. If the works cited
entry begins with the title of a work, then use the same title for your in-text citation. If
the title of the work is long, use the first meaningful words of the title (usually the first
three words of the title).
 If you give credit to the author within the sentence, do not include their name in the intext citation. However, do add any page numbers that are explicitly given.
One Author—Basic in-text format: last name of the author and the page number.
Correct: According to Mary Summer Rain, “This woman was simply amazing” (39).
Correct: “This woman was simply amazing” (Rain 39).
Incorrect: According to Mary Summer Rain, “This woman was simply amazing” (Rain 39).
Two Authors
 Should include both last names connected by and
 List the names in the order they appear
Diversity within a group setting has several advantages that contribute to its overall success;
however, “A serious obstacle to effective collaboration is the tendency of participants to
establish homogeneous groups” (Gong and Dragga 69).
Works Cited
Gong, Gwendolyn, and Sam Dragga. A Writer’s Repertoire. Addison Wesley Longman, 1995.
Three or More Authors
 List only the last name of the first author, followed by et al. and the page number
“We recognize that culture plays a role, but it is—and, indeed, cannot be—the sole factor
explaining economic success” (Baumol et al. 8).
Works Cited
Baumol, William, J., et al. Good Capitalism, Bad Capitalism, and the Economics of Growth and
Prosperity. Yale UP, 2007.
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Corporate Authors—authors are not only individuals but also can be organizations, institutes,
associations, government agencies, etc.
 When an organization is both author and publisher, begin the entry on the Works Cited
page with its title, skipping the author element; then, list the organization as the
publisher.
 Otherwise, if they are different, cite the organization as the author. *The in-text citations
will correspond with this as well.
According to the Heart Foundation, “Your history, eating patterns, alcohol intake, weight and
level of physical activity have a strong influence on blood pressure” (Managing 5).
“For centuries and millennia, world population has experienced fluctuations around a slowly
increasing secular trend” (United Nations 16).
Works Cited
Managing High Blood Pressure. National Heart Foundation of Australia, 2013.
United Nations. Consequences of Rapid Population Growth in Developing Countries. Taylor and
Francis, 1991.
Multiple Works in One Citation
 When borrowing material from more than one work in the same sentence, use semicolons
to separate each source. Remember to cite each of them individually on the Works Cited
page.
Dr. King claims that “we had no alternative except to prepare for [non-violent] direct action,” but
protests against injustice in Baltimore were violent, resulting in 15 buildings and 144 cars being
set on fire (213; “Riots”).
Works Cited
King, Martin L. “Letter from Birmingham Jail.” Reading Literature and Writing Argument,
edited by Missy James and Alan P. Merickel, custom edition for Oklahoma City
Community College, Pearson Education \ Prentice Hall, 2008, p. 223.
“Riots in Baltimore: Five Fast Fact You Need to Know.” Heavy, 28 Apr. 2015, heavy.com/news/
2015/04/freddie-gray-funeral-baltimore-police-protests-riots/.
Repeated Citations from the Same Source
 In a paragraph, you may want to use a source multiple times.
 As long as no other source interferes within the paragraph, you can give a single in-text
citation immediately after you have finished borrowing the information.
 Make sure you list all of the pages that are borrowed in the parenthetical citation.
The book I Know Why The Caged Bird Sings shows the value of community through a “summer
picnic fish fry…the biggest outdoor event of the year.” Everyone attends; “All churches were
represented” and the “recipe, guarded in the family like a scandalous affair” (Angelou 137-39).
Works Cited
Angelou, Maya. I Know Why the Caged Bird Sings. Bantam Books, 1993.
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More Than One Work with the Same Author
 Include a shortened title to the in-text citation so that the reader is directed to the correct
source on the Works Cited page.
Personal experience is effectively used to connect with the audience: “And the whole building
rocked with prayer and song. Still I kept waiting to see Jesus” (Hughes, “Salvation” 549).
However, in Not Without Laughter, the character Sandy Rogers is used to convey Hughes
message as he recalls his experience as a youth. Hughes states, “But Sandy had never had to sit
outdoors in the darkness waiting for her before” (Not 12).
Works Cited
Hughes, Langston. Not Without Laughter. Alfred A. Knopf, Inc., 1971.
---. “Salvation.” McGraw-Hill Reader: Issues across the Disciplines, authored by Gilbert H.
Muller, edited by Nancy Huebner, customized 12th edition for Oklahoma City Community
College, McGraw-Hill Education, 2014, pp. 548-550.
NOTE: When documenting multiple works from the same author on the Works Cited page, first
cite the author’s name as usual; then, instead of repeating the author’s name, replace it with three
hyphens, followed by a period. Also, alphabetize the order according to its title.
No Author: If the work does not have an author, do not use “Anonymous” as the author. Instead,
cite according to its title, providing any page number if given.
 If the title is in italics in the Works Cited entry, use italics in the in-text citation also.
 If the title has “quotation marks” around it, put quotation marks around it in the in-text
citation as well.
In the Epic of Gilgamesh, Shamhat describes Gilgamesh as one who is “perfect in strength like
a wild bull lording it over the menfolk” (Epic lines 211-12).
Works Cited
Epic of Gilgamesh. Translated by Andrew George, Penguin Classics, 2003.
No Page Number
 If the borrowed source lists explicit paragraph, chapter, section, etc., numbers instead of
page numbers, cite according to that number.
 Do not manually count page or paragraph numbers.
According to Governing, only four states have legalized recreational Marijuana (“State”).
In Peter Kreeft’s book Socratic Logic, “Venn Diagrams are quite efficient in distinguishing valid
and invalid syllogisms…” (ch.11, sec. 4).
Works Cited
Kreeft, Peter. Socratic Logic. Edited by Trent Dougherty, St. Augustine’s Press, 2010.
“State Marijuana Laws Maps.” Governing, 25 May 2016, www.governing.com/gov-data/safetyjustice/state-marijuana-laws-map-medical-recreational.html.
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No author
and no page
number

Time Based Media
 For audio and video recordings, cite the numbers of hours, minutes, and seconds.
Transformative Leadership Theory includes “building a shared vision” (Shields 00:01:06).
Works Cited
Shields, Carolyn. “Transformative Leadership for Social Justice.” YouTube, 01 Oct. 2015,
www.youtube.com/watch?v=7YEsZNbfg-c.
Poetry and Line Numbers
 In an edition, when the line numbers are displayed and the poem exceeds one page, use
line numbers instead of page numbers since the page number will appear on the Works
Cited page.
 Also, only use lines the first time you cite; then, just the number(s) every time after that.
 Do not count the lines by hand. If the line numbers are not explicit, use the page number.
 Also, if you want to use more than one line of poetry, use a forward slash ( / ) with a
space before and after it to show the break.
 Preserve all punctuation and capitalization of the original lines as they appear in the
source.
Theodore Roethke, in his poem “Meditation at Oyster River,” claims that “The wind slackens,
light as a moth fanning a stone: / A twilight wing, light as a child’s breath / Turning not a leaf,
not a ripple” (lines 17-19).
Works Cited
Roethke, Theodore. “Meditaiton at Oyster River.” Reading Literature and Writing Argument,
edited by Missy James and Alan P. Merickel, custom edition for Oklahoma City
Community College, Pearson Education \ Prentice Hall, 2008, pp. 329-331.
Scripture: (Bible or Qur’an)
 The first time you use the work, state in your paper (whether in the sentence or in an intext citation) the element that will begin the Works Cited page (usually the version).
Then, every time after that only state the name of the book, followed by a period and the
number of the verse.
 If you mention the version in the sentence, only put the name of the book, followed by a
period and the number of the verse in the parenthetical citation.
 Bible or Koran is not italicized; however, the names of specific editions are italicized.
The power of love is exemplified when Jesus states, “For God so loved the world that He gave
his one and only Son that whoever believes in Him will not perish but have eternal life” (New
International Version, John 3.16) Later on, Jesus commands his disciples to “love one another”
in the same way that he loves them (John 13.34).
Works Cited
New International Version. Edited by Kenneth L. Barker, Zondervan, 2002.
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Block Quotes:
 For more than three lines of poetry or four lines of prose, press Enter and begin the quote
on a new line. Press Tab twice to set the quote off 1inch from the left margin of the
paper. Double space your entry. Block quotes do not need quotation marks. However,
they do need to include a parenthetical citation at the end unless credit has already been
given to the author in the sentence, and there is no page number. End punctuation for a
block quote needs to go at the end of the sentence, not after the parenthesis. See the
example of a quote from the short story “A Modest Proposal” below:
The number of souls in this kingdom being usually reckoned one million and a
hair, of these I calculate there may be about two hundred thousand couples whose
wives are breeders; from which number I subtract thirty thousand couples who are
able to maintain their own children, although I apprehend there cannot be so
many. (Swift 239)
Works Cited
Swift, Jonathon. “A Modest Proposal.” Reading Literature and Writing Argument, edited by
Missy James and Alan P. Merickel, custom edition for Oklahoma City Community
College, Pearson Education / Prentice Hall, 2008, pp. 238-244.
Indirect Source:
 Borrowing from the original source is most credible; however, sometimes when you are
reading a work, you will see the author of that source quote or paraphrase someone else.
Using this information would mean that you are using an indirect source.
 If you incorporate an indirect source into your paper, use the abbreviation qtd. in
(quoted in) before the indirect source.
 Briefly clarify the relationship between the two sources by explaining the situation in
your paper.
According to the New York Times, “The way to close the dark pages of your own history is not
by defaming the histories of other countries with irresponsible and baseless decisions,” Turkey’s
foreign minister, Mevlut Cavusoglu, wrote on Twitter (qtd. in Smale and Eddy).
Works Cited
Smale, Alison, and Melissa Eddy. “German Parliament Declares, Armenian Deaths a Genocide,
Angering Turkey.” New York Times, 02 June 2016, www.nytimes.com/2016/03/03/
world/europe/Armenian-genocide-germany-turkey.html.
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CREATING THE WORKS CITED PAGE
Through the course of your paper, you have been researching different sources, borrowing
information to use in your paper, and creating an in-text citation as a reference to the Works
Cited page. Now it’s time to take each one of those sources that you have used and appropriately
document them on a separate, back page. If teachers, for example, ask “Have you documented
all of your sources?” They are wanting to know this very thing: if when you borrowed the
information and put it in your paper, did you make an effort to cite it in the text and then gather
the needed information to document the material on the Works Cited page. If the answer is yes,
you have avoided plagiarism. However, before you begin, here are some things to remember:

Documentation Guidelines
 Gathering the information may include doing extra research on the source or looking at
the About Us section on a website.
 The Works Cited page is the last page of the document with your last name and a page
number in the right hand corner. The source is called an entry.
 The page has the title Works Cited centered on the first line with no special formatting,
and if there is only one entry, it is called Work Cited.
 List the entries in alphabetical order. Begin with the author’s name, and if no author is
given, proceed with the title of the work either in quotation marks or italics. Alphabetize
the entry using the first meaningful word of the title (not A, An, The, etc.). For example,
“Last Samurai, The.”
 Double-space your entries, but do not put extra spaces between each new source. For the
purpose of formatting, the spacing in the following examples is not MLA format.
 Remember to punctuate your entry exactly like the examples, ignoring any special use
capital letters after periods and lower case letters after commas except for proper nouns.
 The first line of your entry stays aligned to the left while every line after that one entry is
one tab. Note: when you try to tab your line inward, it will move the entire entry, so use a
Ctrl Tab to indent every line after the first line.
 Check to see if your page number limit includes this page or not.
 An example of a Works Cited page is provided on page 18 of this handout.
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Documentation Details
In the previous examples, you have seen the Works Cited page in action, correlated with its intext citation. Now, let’s take a closer look into the details within developing the MLA style of
documentation. In the past, how a source was documented on the Works Cited page depended
upon what type of source it was. Now, in order to make things more unified and easier to build
upon, MLA uses a template that all sources are to follow. Below is an example of that template:
1. Author.
2. Title of Source.
3. Title of Container,
4. Other Contributors,
5. Version,
6. Number,
7. Publisher,
8. Publication Date,
9. Location.













The author can be a person(s), an organization, institute, agency, or a website.
Title of Source is the name that describes the work, not the name of the author.
Title of Container refers to the name of where the work is stored.
If the work is an independent piece, meaning it is not a part of a collection, a published
article, or a website, Title of Source and Title of Container are the same, but you only
need to list one, Title of Source.
Independent pieces of work are italicized, and works that are a part of a larger collection
are in “quotation marks.”
Title of Container is normally italicized but will not be in quotation marks.
Other Contributors are important to the development of the work and needed for
identification purposes. Therefore, name any narrator, editor, translator, director, etc. in
your Works Cited page that fits the “development” and “identification” conditions by
using phrases such as edited by, narrated by, directed by, presented by, uploaded by, etc.
Versions in print sources are usually called editions. However, they can also be named
something different, for example, unabridged version or expanded version.
A Publisher is an important element to the identification of the work. For a print source,
the publisher is typically found on the back side of its title page. A website will have the
copyright information at the bottom of the site, so use this for publishing information.
Use the most recent Publishing/Copyright/last updated/revision date.
Location denotes page numbers, website urls, database doi numbers, the location of an
event, etc. However, only use page numbers when referring to works such as an
anthology or periodical. Use page numbers when they are clearly marked in the source;
do not manually count them. This goes for paragraph, line, and section numbers as well
as comic strip panels.
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Book: For example, a book called Good Capitalism, Bad Capitalism, and the Economics of
Growth and Prosperity has three authors, William J. Baumol, Robert E. Litan, and Carl J.
Schramm and was published by Yale University Press. Its copyright year is 2007. No additional
contributors such as an editor have been acknowledged in the book.
1. Author.
2. Title of Source.

Baumol, William J., et al.
Good Capitalism, Bad Capitalism, and the Economics
of Growth and Prosperity.

3. Title of Container,
4. Other Contributors,

It is an independent
piece of work,
whole unto itself.

5. Version,
6. Number,
7. Publisher,

Yale UP,

8. Publication Date,

2007.

The last element of
the entry always ends
with a period.

9. Location.

Works Cited
Baumol, William, J., et al. Good Capitalism, Bad Capitalism, and the Economics of Growth and
Prosperity. Yale UP, 2007.
 Use abbreviations for publishing information: UP for University Press.
 Omit initials like Inc., Ltd., Corp., or Co. from the publishing company’s name.
Short work from an anthology or compilation: When citing an essay, short story, poem, or other
work in an anthology or compilation (such as a textbook), follow the example below.
1. Author(s). 2. “Title of Work.” 3. Title of Compilation, 4. Name of Editor or Translator,
5. Version/Edition, 7. Publisher Name, 8. Publication Date, 9. Page Number(s).
Works Cited
Rodriguez, Richard. “The Lonely, Good Company of Books.” The McGraw-Hill Reader: Issues
across the Disciplines, authored by Gilbert H. Muller, edited by Nancy Huebner, 12th
ed., customized for Oklahoma City Community College, McGraw-Hill Education,
2014, pp. 189-193.
Pamphlet/brochure: This type of source often has a corporate author; therefore, use the
instructions stated in the “In-Text Citation” section on corporate authors.
1. Author (if listed). 2. Title of Pamphlet. 7. Publisher Name, 8. Publication Date.
Works Cited
US Army. Army Reserves. US Government Printing Office, 2015.
School of Meteorology. U of Oklahoma, June 2015.
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Government document: When citing a part of a bill, congressional report, or resolution from
US Congress use the example below:
1. Name of Country, Branch of Government, Specific Division. 2. Title of Document.
7. Publisher, 8. Publication Date. 9. Specific Location (may be Congress number,
session number, and/or report number).
Works Cited
United States, Congress, House, Permanent Select Committee on Intelligence. Al-Qaeda: The
Many Faces of an Islamist Extremist Threat. Government Printing Offices, 2006. 109th
Congress, 2nd session, House Report 615.
Dictionaries and Encyclopedias: A dictionary and an encyclopedia are excellent sources for
defining words or offering background information on the paper’s topic.
1. Author. 2. “Name of Term.” 3. Title of Container, 4. Other Contributors (usually an editor),
5. Version/Edition, 7. Publisher, 8. Publication Date. 9. Page Nnumbers if multiple
pages.
Works Cited
“Ambition.” Merriam-Webster Dictionary, edited by Fredrick C. Mish, 11th ed., 2004.
“Counting Crow.” The Guinness Encyclopedia of Popular Music, edited by Colin Larkin, vol. 2,
Stockton P \ Guinness Publishing, 1995, p. 954.
 Only use the name of the publisher if it is different than the name of the dictionary.
 For two publishers, in the order they come, use a forward slash with a space on each side.
Sacred texts: The Bible and Qur’an are scriptural works that follow the guidelines below.
1. Author, Editor, Translator. 2. Title of Version. 4. Other Contributors (editor and/or
translator), 5. Edition Number (if any), 7. Publisher Name, 8. Publisher Date.
Works Cited
New International Version Study Bible. Edited by Kenneth L. Barker, Zondervan, 1984.
Stern, David H., translator. Complete Jewish Bible, Jewish New Testament Publication, 1998.
Legal cases: Court Cases are often used as sources and can be found in books or on websites.
1. Plaintiff v. Responder. 2. Court Title. 4. Other Contributors, 6. Court Citation Number, 8.
Decision Date.
Works Cited
Brendlin v. California. Supreme Court of the US. 06-8120, 18 June 2007. American Civil
Liberties Union, www.aclu.org/legal-document/supreme-court-decision-brendlin-vcalifornia. Accessed 28 Mar. 2016.
 Sometimes an access date is more relevant that a copyright date.
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Short work or article on a website: The publishing information on a website is often located at
the bottom of the page with the copyright information.
1. Author. 2. “Title of Source.” 3. Title of Website, 4. Other Contributors, 7. Publisher Name,
8. Publication or Copyright Date, 9. Web Link.
Works Cited
Medendorp, Liz. “2 Broke Girls Is on the Way to Comedy Bankruptcy.” POPMATTERS,
12 Aug. 2015, www.popmatters.com/review/196304-2-broke-girls-the-complete-fourthseason.
“When Bad Movies Happen to Good People: 13 Flops We’ve Kindly Forgotten.” Cinema Blend,
www.cinemablend.com/new/Bad-Movies-Happen-Good-People-13-Flops-We-KindlyForgotten-32633.html. Accessed 27 July 2016.
 Often, a website offers no date information; you may use the date you originally accessed the
website. If so, write the descriptive term Accessed, followed by the date after the URL.

 Do not use http:// within the web address on the Works Cited page.
 If the copyright is the same name as the website name, do not duplicate.
Film: Using a DVD set, a student can view an episode from it in order to discuss subject material
such as great acting skills from one of the main characters, the storyline, plot setting etc...
1. Individual’s Name, description. 2. “Title of Episode.” 3. Title of Show, 4. Name of Creator
6. Season Number, Episode Number, 7. Producer, 8. Year DVD was released,
9. Disc Number.
Works Cited
Dennings, Kat, performer. “And the Pity Party Bus.” 2 Broke Girls, created by Michael Patrick
King, season 5, episode 16, Warner Brothers, 2016, disc 4.
 If you are just focusing on the episode as a whole and not a specific character’s performance,
you only need to identify the creator of the series.

 If the focus is on the film or TV show as a whole, begin with just its title and add any other
significant information such as director or creator as Other Contributors.

Work of art: If a person visits an art gallery or museum to view a piece of work, documentation
for that source will follow these directions.
1. Author. 2. Title of Source. 8. Creation Date 9. Name of Location, City.
1. Author. 2. “Title of Work.” 3. Title of Collection, 8. Creation Date, 9. Location, City.
Works Cited
McKinney, Victoria. Butterfly. 1988, Red Earth Art Gallery, Oklahoma City.
Matisse, Henry. “L’Algerienne.” Matisse in His Time: Masterworks of Modernism from the
Centre Pompidou, Paris. 1919, Oklahoma City Museum of Art.
 Sometimes a piece is a part of a larger collection like the second example.
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Social media post: In place of a title, use the first several words if the post is long (ex. Facebook)
or the entire tweet if from Twitter. The post should be enclosed in quotation marks as well.
1. Author. 2. “First words of post.” 3. Title of Website, 8. Post Date, Time. 9. Web Link.
Works Cited
@okcthunder. “Happy birthday today to Steven Adams.” Twitter, 20 July 2016, 9:00 am.,
twitter.com/okcthunder.
 Remember to omit htttps:// from the web links on the Works Cited page.
Print periodical: A periodical is an article in scholarly journals, newspapers, and magazines.
Use this for a print version and not an online version.
1. Author. 2. “Title of Periodical.” 3. Name of Newspaper (or article/journal). 4. Other
Contributors such as editor or photographer, 7. Publisher (if different from periodical
name) 8. Publication date, 9. Page number.
Works Cited
Bell, Trey, editor. “OCCC Gamers Level up at Convention.” Pioneer [Oklahoma City], 03 June
2016, p. 1.
Vardeman, Brady. “Buddy Hield Headed to New Orleans as the No. 6 Pick in NBA Draft.” Tulsa
World, 24 June 2016, p. 1B+.
 If the city of publication does not appear in the name of the periodical, put the publishing city
in brackets after the name of the newspaper, journal, or magazine.

 However, do not add the city to the name of nationally published newspapers ie. Wall Street
Journal, USA Today, The Chronicle of Higher Education.

 If the article appears on more than one page, add a + sign after the page number.
Corportate Author: An organization such as a government agency, an association, or institute
can be used as a good source of information as well serve as an author. Sometimes, an
organization will publish their own document, or they will have someone else publish their work.
 If the publisher and organization are the same:
2. Title of Source. 7. Publisher Name, 8. Publication Date.
 If they are different, use the organization as the author as shown below:
1. Name of Organization. 2. Title of Work. 7. Publisher Name, 8. Publisher Date.
Works Cited
Managing High Blood Pressure. National Heart Foundation of Australia, 2013.
United Nations. Consequences of Rapid Population Growth in Developing Countries. Taylor and
Francis, 1991.
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Personal interview: Interviews are also a great source of direct information. However, they can
be found in different forms: personal face-to-face, personal telephone, independent television
interview, or independent radio broadcast.
1. Interviewee(s). 2. Type of Interview. 8. Date of Interview.
1. Interviewee(s). 3. Title of Container, 4. Other Contributor 8. Publication Date,
9. Page(s) if published.
Works Cited
Williams, Brittany. Personal interview. 15 June 2016.
Trump, Donald. Fox News, interviewed by Megyn Kelly, 17 May 2016.
Live events and performances: Follow the examples below on how to cite live presentations
such as a conference, workshop, concert, lecture, address, etc.
1. Speaker or Author’s Name, descriptive name (optional). 2. “Title of Event.” 3. Name of
Meeting. 4. Other Contributors (if given). 9. Name of Event Location, City of
location (unless already in the name of location), Date of Event.
Works Cited
Baron, Michael, director. “Dreamgirls.” Presented by Lyric Theatre of Oklahoma. Thelma Parks
Performing Arts Center. Civic Center Music Hall, Oklahoma City, 02 July 2016.
“Dreamgirls.” Presented by Lyric Theater of Oklahoma, directed by Michael Baron. Thelma
Parks Performing Arts Center. Civic Center Music Hall, Oklahoma City, 02 July 2016.
Charlotte, Gambil. “How to Lead the Next Generation.” Youth America Leadership Conference.
Civic Center Music Hall, Oklahoma City, 10 Nov. 2016.
 If you are focusing on a specific performer ie. singer, actor, or director, list the individual with
a descriptive title following the name.

 However, when discussing “Dreamgirls” in general, use the second example. You do not have
to mention the director’s name, but it is a suggestion.

YouTube video: If the author is the same as uploader, only state the author’s name.
1. Author or Speaker (if applicable). 2. “Title of Movie or Video.” 3. YouTube,
4. Uploader, 8. Published or Uploaded Date, 9. Web Address.
Works Cited
Meyers, Pamela. “How to Spot a Liar.” YouTube, uploaded by TED Talks, 13 Oct. 2011,
www.youtube.com/watch?v=P_6vDLq64gE.
“Karma! Bully Who Picks on Disabled Boy Gets a Good Taste of His Own Medicine.”
YouTube, uploaded by Urban Warfare Channel, 08 May 2016, www.youtube.com/
watch?v=rENQ-di2qk8.
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Nested Sources: Online Database
Often, you will find a source that is stored inside a larger host, for example, a digital library such
as JSTOR or EbscoHost, eBooks or digital downloads, or even a movie or documentary on
Netflix or Hulu. Fill in as much of the template that applies to the identification and production
of the source.
Article from a periodical contained in a database: Online databases are the new digital
libraries. Research can be done more quickly and conveniently by utilizing resources like
EbscoHost, offered through OCCC’s online library.
1. Author.

Harper, Kevin.

2. Title of Source.

“Medical Marijuana Emerges from the Shadows.”

Container 1
3. Title of Container,

Public Management,

4. Other Contributors,
5. Version,
6. Number,

vol. 97, issue 6,

7. Publisher,
8. Publication Date,

July 2015,

9. Location.

pp. 20-23.

Container 2
3. Title of Container,

MasterFILE Premier,

4. Other Contributors,
5. Version,
6. Number,
7. Publisher,
8. Publication Date,
9. Location.

http://web.b.ebscohost.com/ehost/detail/detail?vid=24&sid=5f
6f5b06-0045-4835-bef88bf75b674d65%40sessionmgr103&hid=109&bdata=JnNpdG
U9ZWhvc3QtbGl2ZQ%3d%3d#AN=103352321&db=f5h

Works Cited
Harper, Kevin. “Medical Marijuana Emerges from the Shadows.” Public Management, vol. 97,
issue 6, July 2015, pp. 20-23. MasterFILE Premier, web.b.ebscohost.com/ ehost/
detail/detail?vid=24&sid=5f6f5b06-0045-4835-bef8-8bf75b674d65%40sessionmgr
103&hid=109&bdata=JnNpdGU9ZWhvc3QtbGl2ZQ%3d%3d#AN=1033523.
 Always omit the http:// from web links on the Works Cited page.
 Web links have a tendency to start a new line when adding them. You may have to break the
URL up and piece it onto the line.

 Remove all hyperlink formatting, blue color and underline.
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Serialized Sources in a database: Often, you will find websites that store several kinds of print,
video, and audio sources. For example, if you search Shawshank Redemption, you will discover
it is actually book one of the 1982 printed collection called Different Seasons. This eBook
(electronic book) is being offered for viewing through a download (some offers are free and
others cost). To cite a source that is hosted by another, follow the example below:
1. Author. 2. “Title of Work.” 3. Title of Container 1, 4. Other Contributors, 5. Version,
6. Number, 7. Publisher, 8. Publication Date, 9. Page Numbers. 3. Title of Container 2,
9. Web link.
Works Cited
King, Stephen. “Rita Hayworth and Shawshank Redemption: Hope Springs Eternal.” Different
Seasons, vol. 1, Penguin Group, pp. 17-20. Good Reads, www.goodreads.com/book/
show/39664.Rita_Hayworth_and_Shawshank_Redemption.
eBooks not part of a series: Some eBooks may not be part of a collection or series.
1. Author. 2. Title of Book. 4. Other Contributors, 5. Version, 6. Number, 7. Publisher Name,
8. Publication Date. 3. Name of Container 2, 9. Web Link.
Works Cited
Smith, Betty. A Tree Grows in Brooklyn. Harper Collins, 2009. OverDrive, www.overdrive.
com/media/50841/a-tree-grows-in-brooklyn.
Film from a database: Note the name of the significant contributor first. This is dependent on
how the film or TV show is used in the paper.
1. Name of Performer 2. Title of Movie. 4. Other Contributors (Director/Narrator),
7. Producer, date. 3. Container 2, Name of database, 9. Web address.
Works Cited
Freeman, Morgan, performer. An Unfinished Life. Directed by Lasse Hallstrom, Revolution
Studios, 16 Sept. 2005. Netflix, www.netflix.com/watch/70011216?trackId=13755589
&tctx=0%2C0%2C18c99f99-c4b0-43dd-942f-f41d1a1ee4b6-18004521.
 If you are just talking about the film in general, you do not need to mention any actor’s name
in the first entry. Skip to the title otherwise.

Episode from a television series on a database: For a television series, follow the same pattern
as with films, but note the air date and the episode number.
2. “Title of Episode.” 3. Title of Series, 4. Other Contributors, 5. Version, 6. Number,
7. Producer, 8. Aired Date, 3. Name of Container 2, 9. Web link.
Works Cited
“New Dance Coach in Da House.” East Los High, created by Carlos Portugal and Kathleen
Bedoya, season 2, episode 1, Hulu Original, 09 Aug. 2014, Hulu, www.hulu.com/
watch/652872.
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Blank MLA Template
Use the template below to plot and organize each source. First, gather as much information from
that source as you can; then, fill in the blank spaces of the template with the gathered
information. After you have finished filling in everything, use the information to create a citation
on the Works Cited page in the same order seen in the template.

1. Author.
2. Title of Source.
Container 1
3. Title of
Container,
4. Other
Contributors,
5. Version,
6. Number,
7. Publisher,
8. Publication Date,
9. Location.
Container 2
3. Title of
Container,
4. Other
Contributors,
5. Version,
6. Number,
7. Publisher,
8. Publication Date,
9. Location.
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Works Cited
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sessionmgr103&hid=109&bdata=JnNpdGU9ZWhvc3QtbGl2ZQ%3d%3d#AN=1033523
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